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Welcome to The Music Box Help System.    The Topics below will help you learn how to use the software
and how to register the demonstration version to receive the fully functional program.    To view a topic 
area, simply click on the underlined topic.

Getting Started
General information about how to use The Music Box.

Configuring the MIDI Device
Your MIDI Device (MIDI Sequencer) produces the sounds used by The Music Box for ear training.    The 
Configure MIDI dialog box allows you to access the devices installed on your computer and test them.    
You should confirm that you can successfully produce sounds before proceeding with the program.

Ear Training Methods
Suggested ways to use The Music Box as part of training your ear.

Menu Items
A list of the menu items and their functions.

Toolbar Description
A picture of the toolbar and the functions represented by the buttons.

Usage Agreement
The Usage Agreement for this software.    Please read this section.

How to Register
Information on how to register this software.

Registration Form
The registration form for The Music Box.    This form may be printed or if you do not have a printer, 
please supply the information with your registration fee.

Miscellaneous Information
How to uninstall the program and what to do if you have a comment or suggestion.



Getting Started

Welcome to Music Box - A Personal Ear Training System.    The Music Box is designed to provide you 
with the ability to develop your skill in hearing intervals, chord sonorities and melodic sequences at your 
own pace, using a multimedia computer.    In order for The Music Box to produce the tones required for 
ear training, your computer must have a MIDI (Musical Instrument Digital Interface) sequencer.    Most 
computers with sound cards have this capability.
If you like to learn by trying things out, I suggest you study the Toolbar Description (which you may 
access by clicking this jump) or selecting Help - Toolbar Description in The Music Box menu.    Once you 
understand what the Toolbar buttons do, you can conveniently run the entire application.
The following detailed information will help you understand the process of organizing the program to 
provide you with the tempo, interval selection, instrument sound, melody length, ear training method and
level of difficulty in general....I strongly recommend you take the time to read it.    If you must try things 
out right away however, use the toolbar descriptions to help you on your way!

Simple Steps to Operate the Program
1. Verify the program is accessing the MIDI sequencer properly.    If you received no error messages 

when you began the program your system is probably configured so that The Music Box    can 
access the sound driver.    If you receive an error message at start up about not being able to access 
the sound device or if you hear no sound when playing intervals, chords or melodies, refer to the 
Configure Midi help.

2. Use the Dictation Options dialog to set the characteristics of the dictation sequence that will be 
created for you (i.e. the number of notes, diatonic or chromatic melody, tempo etc.).

3. Select the intervals you wish to practice in the Select Intervals dialog box.    The intervals you choose
in this window will determine the characteristics of your practice session.    For example, if you 
choose only two intervals such as a major second and a tritone, your melodic dictation will remain 
within the whole tone series in chromatic mode.    If you were using the diatonic mode setting, you 
would have to include a few more intervals to get an interesting melody.    With some 
experimentation, you will soon see the relationship between the choices you make in the interval 
selection window and the melodies created by the program.

4. Choose any of the many ear training methods the program offers.
5. Begin your ear training session.

More about configuring the MIDI device.
If it is the first time you have used the program, select the Options - Configure MIDI menu item.    The 
Configure MIDI dialog box that appears contains three controls entitled Device, Channel and Instrument.
If your computer has installed MIDI devices, they will appear in the Device combo box.    If this combo 
box is empty or contains only the MIDI Mapper (a windows applet explained in a moment), devices are 
not available and you will need to reference your windows manual, or sound card documentation to load 
the MIDI sequencer drivers.

If The Music Box is accessing the MIDI sequencer properly, you will hear a middle C play when you 
press the Test button.    If you have several devices listed you may want to experiment to select the one 
that you want.    

The MIDI Mapper is a windows applet that maps source MIDI data to target MIDI devices.    Please read 
the help that is provided with the applet to learn more about the functionality of the MIDI Mapper.    Do 
not change the settings before you have a good understanding of MIDI techniques.

The Music Box internally sets its volume to full.    To adjust the volume see Setting the Volume.
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Ear Training Methods

Interval Practice
Triad Practice
Pitch Recognition
Interval Dictation 
Triad Dictation
Melodic Dictation
Sight Singing



Interval Practice

The Interval Practice window will randomly play intervals selected from the interval choices you have 
checked in the Select Intervals window.    Press the Play button to play an interval and then make your 
choice by pressing the appropriate button in the Interval Choices group box.    Your score for correct and 
incorrect selections will be maintained in the green check (for correct) and red X (for incorrect) edit 
boxes.    

The Play Again button does just that - it will play the interval again.    If you need a little extra help in 
listening to the interval, the program allows you to play the low note or the high note.    This is very useful
in the early weeks when you are just beginning to acquire an ear for intervals.

Finally, the sustain options buttons allow you to select how long you wish the interval (or note) to sustain.
You may wish to select Long to begin and then challenge yourself a little later in    your training by 
moving over to Short.



Triad Practice

The Triad Practice window will randomly play triads selected from the triad choices you have checked in 
the Select Triads window.    Press the Play button to play a triad and then make your choice by pressing 
the appropriate button in the Triad Choices group box.    Your score for correct and incorrect selections 
will be maintained in the green check (for correct) and red X (for incorrect) edit boxes.    

The Play Again button will play the triad again.    To provide additional help in hearing the intervals that 
comprise the triad, the program will play each note from low to high when you press the arpeggiate 
button.

Finally, the sustain options buttons allow you to select how long you wish the triad to sustain.    As with 
intervals, you may wish to select Long to begin and then challenge yourself a little later in your training 
by moving over to Short.



Pitch Recognition

The Pitch Recognition window randomly selects pitches from the C below middle C to the G one octave 
above the G above middle C.    The pitch recognition dialog provides two ways to train your ear.

1. Many music students that do not have perfect pitch enjoy spending time attempting to develop or 
refine this potential latent ability in their own ear    (as a music student myself, I recall numerous 
hours spent in this pursuit).

2. This window also allows you to practice your relative pitch as well by moving from one note to the
next, you should eventually be able to determine the pitch of a note by hearing the interval 
distance to the preceding note.

To begin practicing, simply press the Play button.    Similar to the Interval Practice and Triad Practice 
windows, The Music Box will keep score for you in the green check and red X edit boxes.



Select Intervals

The Select Intervals window allows you to choose the intervals you wish to practice.    If you are just 
beginning to learn to recognize intervals,    I recommend selecting just two or three intervals and adding 
more later as you become comfortable with the different sounds.    When the check box contains the 
check mark (the x), that interval will be included in any interval series dictation, melodic sequence 
dictation or practice session.
Note:
When the program first begins, all intervals are selected.



Select Triads

The Select Triads window allows you to choose the triads you wish to practice.    As with intervals, you 
may wish to select just two to start and add more as you learn the sonorities.    Any triads checked in this
window will be used randomly in triad sequence dictation or in the Triad Practice window.
Note:
When the program first starts, all triads are selected.



Compose (Intervals)

The compose command under the Dictation - Intervals menu item tells The Music Box to create a series 
of intervals to play for dictation.    The intervals will be randomly chosen from the intervals you have 
selected for practice in the Select Intervals dialog.    You may also choose from 2 to 30 intervals for the 
sequence length on the Dictation Options dialog under the Options menu.



Play (Intervals)

This command will play the intervals in the dictation sequence created when you select the Dictation -
Intervals -Compose menu option.    You may alternately press the appropriate toolbar button to play the 
sequence.



View (Intervals)

By selecting Dictation -Intervals -View, The Music Box will display the complete list of intervals (as text) 
in the main window.    Use this feature to compare to the list you record as you listen to the interval 
sequence as dictation.    You may also wish to play interval sequences with the list already displayed, 
just to help you hear the difference between intervals as they are played.



Compose (Triads)

When you choose Dictation -Triads - Compose, The Music Box will generate a sequence of triads to 
play as dictation.    The sonorities (i.e. major, minor, diminished or augmented) will be chosen from the 
list of checked triad types in the Select Triads dialog box.    You may choose from 2 to 30 triads for the 
sequence in the Dictation Options dialog box under the Options menu.

As the sequence plays, write down what you think the sonorities are and then compare you results with 
The Music Box by pressing the View toolbar button or selecting Dictation - Triads -View on the menu.



Play (Triads)

This command plays the triad sequence created under the compose button (or the Dictation -Triads -
Compose menu item).    The tempo is set in the Dictation Options dialog box.    As the sequence plays, 
you should write down the sonorities as you hear them and then compare you answers with The Music 
Box.



View (Triads)

By selecting Dictation -Triads -View, The Music Box will display the complete list of triads (as text) in the 
main window.    Use this feature to compare to the list you record as you listen to the triad sequence as 
dictation.    You may also wish to play triad sequences with the list already displayed, just to help you 
hear the difference between triad sonorities as they are played.



Stop Dictation

This command will stop a melodic dictation or an    interval or triad sequence as it is playing. You may 
use the command or the toolbar button with the stop sign (and white exclamation point).    When a 
dictation is stopped, the create and play menu items and toolbar buttons will enable again.



Compose (Melodic Dictation)

Taking melodic dictation is perhaps the most difficult ear training challenge.    One difficulty is that it 
usually takes two people to accomplish - one to play the melody and one to take the dictation.    The 
Music Box will allow you to practice dictation by yourself.
Using the Dictation Options dialog box under the Options menu, you may choose the number of notes to
use in the melody from 2 to 30.    You may also choose the tempo, from Adagio to Allegro.
You may also ask The Music Box to create either a chromatic melody or a diatonic melody.    If you 
choose diatonic, the program will remain within the pitches offered by the major scale for the first note of 
the melody.    If you choose chromatic, anything goes!    The diatonic choice would be the best place to 
start.
Finally, as preparation, you should be sure that the intervals you wish to practice are selected in the 
Select Intervals window.    You may choose as few or many as you wish, however, if you are in the 
diatonic mode you may need a few more to get an interesting melody.
When you click the compose menu item or press the compose button the program will create a melody 
based on all the criteria mentioned above.    The program will display the first note of the dictation so you
will know where to start.    All you have to do then is either select the Play command from the menu or 
press the little button in the Compose, Play, View group for Melodic dictation.    The Play button has a 
little ear placed in the left corner.    
As the melody plays, your job is to write down the melody as best you can.    You may repeat the melody
as often as you like.    The Music Box remembers the melodic sequence until you Compose a new 
sequence.    When you have completed the dictation, select the View menu command or press the 
button in the Melodic Dictation button group that has the little looking glass and the program will display 
the score for you to check your results.
Note:
If the word more... appears in the lower right hand portion of the screen, you need to expand the window
to view the entire score.



Play (Melodic Dictation)

To play a melodic sequence as dictation, simply press the toolbar button with the little gray ear (in the 
melodic dictation toolbar group) or select the Dictation -Melodic - Play menu item.    Be sure to have your
pen or pencil ready!



View Score (Melodic Dictation)

To view the score for a melodic dictation sequence, select the Dictation - Melodic - View Score menu 
item or press the toolbar button with the three notes and a looking glass.    If the word more... appears in 
the lower right hand portion of the screen, expand the size of the window to view the entire score.    
Note: 
If you resize the window during the playback of a dictation sequence, you may notice a disruption in the 
steady rhythm.    This is the result of windows internals and is not problem.



Interval Dictation

As you become familiar with the sounds of various intervals, you may wish to hear a series of intervals 
as dictation to determine your ability to distinguish them as they progress through a sequence.    To 
create an interval dictation sequence you need to do the following:

Select the intervals you wish to practice
Compose Intervals for Dictation
Play Intervals as Dictation
View Interval Sequence



Triad Dictation

Just as with intervals, you may wish to listen to a series of triads to determine your ability to identify the 
correct sonorities.    Follow the following steps to create a dictation sequence, play the sequence and 
view the sonority descriptions.

Select the triads you wish to practice
Compose a triad sequence for dictation
Play a triad sequence as dictation
View triad sequence as text



Melodic Dictation

Melodic dictation is the most powerful feature of The Music Box.    After you have decided the intervals 
you wish to practice, the tempo at which you wish to receive the dictation and the mode (diatonic or 
chromatic), The Music Box will play a new melody for you every time.    To create, play and then view the
score of a melodic dictation follow these steps:

Compose a Melody
Play the Melody
View the Melodic Dictation Score

Remember that you can adjust the level of difficulty by selecting either Chromatic (more difficult) or 
Diatonic on the Dictation Options dialog box.    Beginning with fewer notes (less than 30) and a slower 
tempo (Andante or Adagio) will make the dictation sequence easier to record.

You may also play the melody one note at a time at your own pace by using the Next Melody Note and 
the Previous Melody Note buttons.



Dictation Options

The Dictation Options dialog box provides the ability to adjust the tempo for dictation playback, to 
choose the number of melodic notes, intervals and triads you wish to have in a dictation sequence, the 
ability to create either chromatic or diatonic melodies and to choose if you wish the first note of a 
dictation melody to be played for sight singing.

Dictation Tempo
The tempo choices range from Adagio (about one note every five seconds) to Allegro ( about one note 
every .8 seconds).

Dictation Amounts
The numbers of notes, intervals or triads for playback must be between 2 and 30.

Melodic Mode
Finally,    you may choose either the Chromatic melodic mode or Diatonic.    Chromatic melodies follow 
no home key.    In the diatonic mode, the melody that The Music Box creates will remain within the 
diatonic scale for the major key associated with the first note of the melody.    For example, if the first 
note is a G natural, the entire sequence will be created from the combination of the intervals you have 
chosen to practice on the Select Intervals window and the notes available in the G major scale.    The 
Diatonic mode is the recommended place to begin and as you advance you can venture out into the 
chromatic mode.

Chromatic Mode and Interval Spelling
You will notice that when you are operating in the Chromatic Mode setting for melodic dictation certain 
interval distances will be spelled alternatively.    For example, if you have chosen the minor third as one 
of the intervals you wish to be used in generating dictation sequences, it will on occasion be written on 
the score as an augmented second.    This is due to the nature of generating melodies randomly.
Lets assume you have decided to practice on minor seconds and major thirds and have generated a 
melody that begins on B.    The program decides the next note should be a minor second below the B, so
it correctly writes an A#.    The next randomly generated    note after that however, is a major third above 
the current note (A#).    In this case, the correct spelling would be to C## (C double sharp).    The process
can continue greater degrees of obscurity by randomly generating another major third up, which would 
be an E##.    Ultimately the process cycles into unknown territory, since the next third higher is the 
equivalent of G###.    To avoid such situations the program resets itself on white notes on the piano 
keyboard.    That is why the program when requested to create a note a major third above A#, simply 
uses the note D.    
You will notice this type of spelling anomaly to a greater of lesser degree of frequency depending on the 
types of intervals you have chosen to practice.    

Play First Melody Note
If you wish to use The Music Box for sight singing, check this box.    When you compose a new melody, 
The Music Box will play the first note for you and automatically display the score.    Your job is to do your 
best to sing it accurately.    Check your singing by playing the melody after you have sung it or use the 
Next Melody Note and Previous Melody Note buttons to step through the melody as you sing it.



Configure MIDI

The Configure MIDI dialog box provides the ability to select different MIDI devices, the channel the 
program will use to communicate with the MIDI device and the instrument sound (sometimes called the 
patch).
If you successfully create sounds with this program either using the MIDI Mapper or one of the devices 
listed in the Device combo box then you need not investigate the complexities of the MIDI interface.    If 
you do not get any sound, confirm you have a correctly installed sound card and study up a bit on the 
MIDI interface.    A simple explanation of the components used by this program follow:

Device
The Device combo box contains the MIDI Mapper as its first item.    This is a windows applet available in 
control panel.    Its function is to map MIDI input data to a MIDI device.    Among the functions of the MIDI
Mapper is ability to re-map information.    This should not be necessary for this program and in general, if
the MIDI Mapper should be set up to provide you with access to a MIDI Device.    You can also select 
other devices that this program identifies on your computer.    Press the Test button to determine if the 
connection with the device is functioning properly.    The Test button plays a Middle C if all is well.    

Channel
There are generally 16 channels available to send information to the MIDI sequencer.    I have included 
them in the combo box, however the first channel should usually suit your needs.    If you do not get 
sound you may want to try other channels.    Some older devices use channels 11 through 13.

Instrument
This list of instruments is included to make your dictation sessions more interesting and fun.    In the 
language of MIDI, the instrument timbres are often called patches.



Toolbar Description



Usage Agreement

The Music Box is shareware.    Shareware allows users to try software before purchasing.    Unregistered
shareware versions are either fully functional or of limited functionality as is the case with The Music Box
- A Personal Ear Trainer.    The unregistered shareware version of The Music Box - A Personal Ear 
Trainer is yours to try for 30 days.    After the 30 day period has expired, you must purchase the software 
or discontinue its use.
You may to distribute the unregistered shareware version freely.    If you like the program and believe 
that friends, colleagues or fellow students might find it useful, you are encouraged to share it.    This 
networking provides one of the most important methods for this program to reach people that may find it 
useful.    Please note that the registered version of the program may not be copied or distributed without 
the explicit approval of Carner Enterprises.

If you wish to purchase the fully functional version of the software, please see the How to Register 
section of this help file.    Again, the registered version of The Music Box - A Personal Ear Trainer may 
not be distributed.

Disclaimer of Warranty
All versions of The Music Box - A Personal Ear Trainer come as is with no implied or expressed 
warranties.    Users of The Music Box assume full responsibility for its use.



How to Register

To register The Music Box - A Personal Ear Trainer use the Registration Form provided in this help file.    
Send $22.00 ($18.00 registration plus $4.00 shipping and handling) along with the registration form to:

Carner Enterprises
13298 Rocky Ridge Rd.
Silverdale, WA 98383-9511

When you register you will receive the fully functional version of The Music Box.    I will also notify you of 
new releases of the software.    As a registered owner you will also receive discounts on future releases 
of the software should they become available.



Registration Form

The Music Box - A Personal Ear Trainer

Fill out this form and send it with your enclosed check or money order for $22.00 (twenty-two dollars) to:

Carner Enterprises
13298 Rocky Ridge Road N.W.
Silverdale, WA 98383-9511

Choose Print Topic under the File Menu item in this Help window to print this form.

If you do not have a printer, just send in your registration with the information requested 
below.

Please PRINT clearly

Name: ____________________________________________________

Street: ____________________________________________________

City: ____________________________________________________

State: ______________________________    ZIP__________________

Price per copy: $18.00
Shipping and handling: + 4.00
Total: $22.00

Site licenses and bulk purchase discounts are available.    Please write Carner Enterprises for details.
Installation diskette is 3.5 inch.
Price is guaranteed through May of 1996.
If you have a moment, please indicate how you learned of The Music Box. 

____ Demo Disk
____ On-line service (please indicate name of service ____________ )
____ Other (please note: )

Thank you for registering your copy of The Music Box - A Personal Ear Trainer.



Sight Singing

Sight Singing is a very important component in your ear training program.    The Music Box provides the 
ability for sight singing by following these steps:

1. Check the Play First Melody Note check box in the Sight Singing group box in the DictationOptions 
dialog box (toolbar button with the little metronome).    This will tell The Music Box to play the first 
note for you each time you compose a new melody and to display the score for viewing.    If you miss
the first note after composing a melody for sight singing, press the Next Melody Note button or use 
the Dictation - Next Melody Note menu command to play the first note.

2. Compose a new melody (use the menu options under Dictation or press the toolbar button with the 
pencil above the little notes).    The program composes and displays a melody for you to sing.    You 
should have the first note of the melody in your ear because you requested The Music Box play the 
first note for you by activating the sight singing mode in the Dictation Options window.    Your job is to 
sing the melody and once you have completed your attempt, press the play button to see how you 
did.    You may sing and play the melody as much as you like.    The melody will be retained until the 
next time you press the compose button or choose compose melody under the menu items.

3. You may also play the melody one note at a time at your own pace by using the Next Melody Note 
and the Previous Melody Note buttons.

I recommend that you begin with a shorter melody.    In the DictationOptions dialog box set the number of 
melody notes to 10 or less.    It will be easier to retain the entire melody in your ear as The Music Box 
plays it back to you.    As you gain confidence, you can gradually increase the length of the melody all the 
way up to 30 notes if you wish.



Exit

Close The Music Box application.



Toolbar

Check this option off or on to view or remove the toolbar from the main window.



Status Bar

Check this option off or on to view or remove the status bar from the bottom of the main window.



Help

This menu item lists commands to view various topics in the help system.



Next Melody Note

When you select the Dictation - Next Melody Note command the program will play the next note in the 
melody (starting with the first note).    This feature allows you to step through the melody at your own 
pace for your earliest ear training sessions or for sight singing practice.    You may move backwards in 
the melody by pressing the Previous Melody Note button (or use the menu command).



Previous Melody Note

When you select the Previous Melody Note under the Dictation Menu item, the program will play the 
previous note in the melody.    The Next Melody Note and Previous Melody Note commands (and toolbar
buttons) allow you to step back and forth in the melody as an alternate way of taking dictation at your 
own pace or for practicing sight singing.



Setting the Volume

The Music Box requests the maximum volume from the sound device.    To adjust the volume you must 
either adjust the volume control on your speakers or use the sound card interface to adjust the volume.



Miscellaneous Information

Uninstalling The Music Box.
To remove The Music Box from your computer, simply delete the install directory.    The program defaults
to c:\musicbox.    The registered version also builds a file named musicbox.ini in your c:\windows 
directory.    This may also be removed if you wish.

Comments, suggestions and recommendations.
I am most interested in your comments on this program.    Its structure is the result of what I felt would 
have been useful to me as I earned my music degrees and the suggestions of friends and professional 
musicians who offered comments during the development cycle.    If you would like to offer a comment or
recommendation for a future release, please write to me at the address on the registration form.    

If you discover a program error, please let me know so that I can correct the problem in future releases.   
The program has undergone thorough testing, but the potential always exists for an error to go 
undetected.    

Technical Support
If you have technical difficulty with the program, I will attempt to respond promptly if you contact me by 
mail at the address listed on the registration form.    I cannot guarantee an understanding of the myriad 
sound cards and configurations that exist.    If you have a sound card and The Music Box does not 
produce tones, please look first at your sound card documentation.




